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Abstract: Digital image processing is 

increasingly being used in a variety of 

industries, including food processing, medical 

science, particle technology, cement, and 

powder manufacturing. Medical image 

processing is a discipline in medical science 

that involves the use of technology to take 

images of the human body's interior in the 

least invasive way possible. As medical and 

biological sciences advance, imaging has 

become a more important discipline. One of 

the most useful programs is ImageJ, a public-

domain Java image processing program 

inspired by NIH Image for the Macintosh. In 

this study, we demonstrated some, but not all, 

applications of ImageJ in the medical field and 

for medical and biological students that can be 

easily implemented in their institutions.  One 

of these applications was bacterial cell 

counting, in which a microscopic image of 

 

 

 

 

 

 

 

 

 

 

 gram-stained bacterial cells was captured 

using a student's smartphone, treated with 

ImageJ, and the bacterial cells were easily 

counted automatically using ImageJ. The 

second application of ImageJ in this review 

was to calculate the antimicrobial zone of 

inhibition. We calculated the percentage of 

the inhibition zone for three different 

amoxicillin antibiotic brands using very 

simple steps. The third application of ImageJ 

was to analyze a CT scan brain images, and 

we were able to define the hemorrhage 

location. Finally, we demonstrated that this 

free software can estimate protein-protein 

colocalization. This technique is useful in 

many cell biological and physiological studies 

to demonstrate the relationship between pairs 

of biomolecules. In another example of co-

localization, the researchers confirmed the 

SyGCaM2-mCherry sensor's presynaptic 
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localization to hippocampal synapses, where 

it was co-localized with a bassoon (a 

presynaptic protein) in the stratum radiatum 

of area CA1. In general, ImageJ is a very 

useful, free program that can be used easily by 

specialized people and the beginner medical 

students. 

Keywords: ImageJ, Fiji, Digital image 

processing, bacterial cell counting, protein-

protein colocalization.  

Introduction 

The field of medical image processing uses 

technology to take images of the human body 

with the least amount of invasiveness 

possible. Consequently, imaging has become 

an important field of research as a result of 

developments in the biological and medical 

sciences. Although there are many image 

processing programs available, most of them 

lack flexibility and do not support complex 

image editing. ImageJ is one of the programs 

that could make this field easier and more 

engaging. Wayne Rasband, who retired from 

the National Institute of Mental Health's 

Research Services Branch in 2010, created the 

widely used public domain Java image 

processing and analysis tool ImageJ at the 

National Institutes of Health and the 

Laboratory for Optical and Computational 

Instrumentation (LOCI, University of 

Wisconsin). Rasband is continues to develop 

the software(1, 2). ImageJ was designed with 

an open architecture that 

provides extensibility via Java plugins and 

recordable macros (3). Users are completely 

free to run, copy, distribute, research, alter, 

and enhance the software because its source 

code is publicly available. To put it simply, it 

enables users to group imaging operations into 

macros, which are text files that are simple to 

create, modify, and debug (4). A Java compiler 

and the built-in editor of ImageJ can be used 

to create custom acquisition, analysis, and 

processing plugins (5). Numerous image 

processing and analysis issues can be resolved 

with user-written plugins, ranging from 

radiological image processing(6), to three-

dimensional live-cell imaging (7), multiple 

imaging system data comparisons (8) and for 

automated hematology systems (9). ImageJ is 

a well-liked platform for teaching image 

processing because of its plugin architecture 

and integrated development environment (4).  

As imagej is constantly updated, ImageJ2 has 

come as a result, where ImageJ2 is a complete 

rewrite of ImageJ tailored for 

multidimensional image data, focusing on the 

field of scientific imaging. Its primary 

objective is to extend the capabilities of 

ImageJ beyond the constraints of the original 

application, enabling support for the 

https://en.wikipedia.org/wiki/Open_architecture
https://en.wikipedia.org/wiki/Plugins
https://en.wikipedia.org/wiki/Hematology
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upcoming generation of multidimensional 

scientific imaging. To maintain backwards 

compatibility, ImageJ2 has been constructed 

to integrate seamlessly with the current 

ImageJ user interface. This enables users to 

continue utilizing ImageJ in their usual 

manner while also gaining the option to 

transition to more potent new features as 

necessary (10). 

Later, the Fiji project has been developed on 

the foundation of ImageJ2 for a considerable 

time, so you might already be acquainted with 

some of the functionalities of ImageJ2-some 

features, like the Updater and Launcher, were 

initially created as part of Fiji (11). It is an 

open-source image processing package, was 

developed by Johannes Schindelin and others. 

It is an update of ImageJ, featuring an 

integrated updating system (11) . The Stable 

release was released on March 7, 2011 

(official release, plugins are continuously 

updated). Fiji's main purpose is to provide an 

ImageJ distribution with a large number of 

bundled plugins. Fiji includes an integrated 

updating system and aims to provide users 

with a consistent menu structure, extensive 

documentation in the form of detailed 

algorithm descriptions and tutorials, and the 

ability to avoid having to install multiple 

components from different sources. There are 

numerous ImageJ plugins with a wide range 

of applications and quality. (12). As a result, 

Fiji attracts an increasing number of active 

users. While Fiji was originally designed for 

neuroscientists (and continues to be so) (13), it 

accumulated enough functionality to attract 

scientists from a variety of fields, such as 

parasitology,(14) cell biology, (15) genetics, life 

sciences in general, material science, etc. Fiji 

is most popular in the life 

sciences community, where the 3D Viewer 

(16) helps visualizing data obtained 

through light microscopy, and for which Fiji 

provides segmentation, registration, and other 

advanced image processing algorithms (11, 17, 

18). ImageJ is still being developed on a daily 

basis, and its users are growing. The most 

recent update was (2.9.0 / September 14, 

2022) (19)
.  

Some examples of ImageJ  

applications 

In this part, we will show some but not all 

applications of ImageJ in medical field that 

can be very useful for medical and biological 

researchers and students. 

Bacterial cells counting 

ImageJ program was applied to an images that 

obtained from gram stained bacterial smear. 

The manual counting of gram stained 

bacteria examined under a microscope 

https://en.wikipedia.org/wiki/Optical_microscope
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becomes very difficult especially, when a 

large number of particles exist in a 

microscopic field. The small size of these 

organisms (0.5–2 μm) usually makes manual 

counting difficult as numbers of organisms 

increase. Here we have applied ImageJ to 

counting of gram stained bacteria(20). Gram 

stained bacteria images were captured by a 

smartphone (Samsung X7) and then 

transferred to the pc and treated using ImageJ. 

The method for enumeration of gram stain 

using ImageJ required the image file to be 

converted from RGB color to 8-bit grayscale. 

Automated counting of the  bacterial particles 

uses threshold algorithms to discriminate the 

features of interest from background. To set 

the counting threshold following opening the 

selected image, the following 

commands (Image → Adjust → Threshold 

→ select algorithm to be 

applied → Apply were used and the image 

converted to a binary image by 

selecting Process → Binary → Make 

binary. bacterial particles were counted using 

the commands Analyze → Analyze Particles, 

with the upper and lower limits for the particle 

size set at 0–infinity, selected to ‘Show 

outlines’ and checked box to ‘Summarize’. 

Each counted particle was outlined and 

numbered in a new window(21). 

Figure 1 showed a microscopic image of the 

bacterial cells captured using a student's 

smartphone where the collected image was 

treated using ImageJ and bacterial cells was 

counted using ImageJ. The total number of 

bacterial particles was 332 bacterial cells. 

This method is less expensive and less 

laborious than other methods and is more 

rapid and reproducible than counting using 

manual microscopy methods. Therefore we 

suggest the application of the ImageJ program 

as an alternative method to manual 

quantification of bacterial cells (21).  

      

 

Figure 1. Bacterial cell counting using ImageJ. A. 

Microscopic image of the bacterial cells captured 

using a student's smartphone. B. Image in A is 

treated using ImageJ and bacterial cells was 

counted using ImageJ. The image sourced from (21). 

A 
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Calculation of the antimicrobial zone 

of inhibition using imageJ 

ImageJ can be used to determine the 

antimicrobial zone of inhibition. The disk-

diffusion agar method tests, also known as the 

Kirby-Bauer test, determine the antibiotic 

sensitivity of bacteria. Antibiotic discs are 

used to determine the extent to which 

antibiotics affect bacteria. In this test, 

antibiotic-containing discs are placed on an 

agar plate with bacteria and allowed to 

incubate. If an antibiotic prevents or kills the 

bacteria, there will be an area around the wafer 

where the bacteria have not grown sufficiently 

to be visible. (22). This is called a zone of 

inhibition.  

The method in brief, an agar plate is first 

spread with bacteria, then a drop (0.2 ml) of 

antibiotics are added. The bacteria is allowed 

to grow on the agar media, and then observed. 

The amount of space around each antibiotic 

plate indicates how lethal the antibiotic is to 

the bacteria in question. Highly effective 

antibiotics will result in a wide ring of no 

bacterial growth, whereas ineffective 

antibiotics will cause no change in the 

surrounding bacterial concentration at all. 

Intermediate antibiotics' effectiveness can be 

assessed using their zone of inhibition. This 

method is used to identify the most effective 

antibiotic to use against a new or drug-

resistant pathogen. In here, we have compared 

the efficacy of amoxicillin syrup (250 mg) 

manufactured at three different companies 

from three different countries (U.K, Egypt and 

Tunisia). The zones of inhibition of the three 

antibiotics were captured using a smartphone 

and the images were treated using the 

following command: (ImageJ → Oval tool → 

Analyze → Measure → repeat the same 

process for each inhibition zone) and then the 

collected data were transferred to an excel file 

and the bar charts was generated as seen in 

figures 2. The bar chat in figure shows the 

percentage of the inhibition zone of the three-

different amoxicillin antibiotic, calculated 

using ImageJ.  

 

 

A 
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Figure 2. A-Using ImageJ to calculate the zones of 

inhibition by the three-different brands of 

amoxicillin antibiotic. B-Bar chart shows the 

percentage of the inhibition zone of the three-

different brands of amoxicillin antibiotic, calculated 

using ImageJ (the experiment is repeated only one 

time just for the demonstration). 

Analyzing CT scan images using 

ImageJ 

Image-processing software for radiology 

applications is in high demand, thanks to 

advances in both image-acquisition and 

image-analysis techniques. The utility of 

existing image-processing software is 

frequently limited by its cost, lack of 

flexibility, and/or specific hardware 

requirements. Many existing packages, in 

particular, cannot directly use images 

formatted in accordance with the DICOM 

(Digital Imaging and Communication in 

Medicine) standard specifications. The ability 

to read DICOM images, combined with the 

recent addition of a macro language for 

ImageJ, has made it possible to develop low-

cost image-processing applications on this 

platform(6). An example of imaging 

techniques that can generate DICOM images 

is Diagnostic computed tomography (CT). In 

brief, CT is a relatively simple, non-invasive 

technique used for diagnostic and surveillance 

purposes. CT imaging scans the body like 

slices of bread, producing cross-sectional 

images or "slices." (23, 24).  

In this part, we have tried to analyze DICOM 

images collected from a patient suffering from 

cerebral hemorrhage, using diagnostic 

computed tomography (CT) technique 

(Alexion, Canon Medical Systems 

Corporation's. Japan) located in radiology 

department in Msallata central hospital 

(Msallata City; Libya) (figure 3).  

 

Figure 3. Alexion, a multi-slice CT scanner from 

TOSHIBA, located in radiology department of 

Msallata central hospital. 

The collected images were transferred using 

USB storage device to a PC were the ImageJ 

software is installed. The target images were 

opened and treated using the following 

command (ImageJ →  image → lookup tables 

→ fire); this command used to show the extent 
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and the distribution of the hemorrhage where 

the yellow color is.  

Figure 4 showed that the hemorrhage is 

located in the parietal lobe of the cerebral 

cortex. In addition to this act we could 

calculate the hemorrhage size using a free 

hand tool and analyze tool, we could also 

generate a 3D image for this hemorrhage.  

 

Figure ستند.خطأ! لا يوجد نص من النمط المعين في الم 4. CT 

scan brain images treated with ImageJ software, 

collected from a patient suffering from cerebral 

haemorrhage; yellow coloured areas show the 

extent of the cerebral haemorrhage. A. images from 

1A to 6A show row images collected from CT scan 

device, these images show the extent and the location 

of the cerebral hemorrhage. B. images from 1B to 6 

B show the same images in A treated using ImageJ 

software.  

Using ImageJ to measure protein Co-

localization 

In fluorescence microscopy, co-localization is 

the observation of the spatial overlap between 

two (or more) different fluorescent labels, 

each with a different emission wavelength, to 

determine whether the different "targets" are 

located in the same area of the cell or very 

close to one another. This technique is 

important in many cell biological and 

physiological studies when demonstrating the 

relationship between pairs of biomolecules(25). 

Another key advantage of ImageJ is its 

abilities in co-localization analysis. Given that 

no single co-localization quantification 

technique is appropriate for all circumstances, 

ImageJ’s large suite of co-localization plugins 

provides options for this additional 

functionality. Since users are not restricted to 

a specific approach, the most appropriate co-

localization technique from the toolbox can be 

chosen. Among others, plugins are available 

to perform qualitative overlays [and convert 

them from Red-Green-Blue (RGB) to the 

color-blind-friendly Magenta-Green-Blue], 

generate Pearson’s coefficients, generate 

Mander’s coefficients. However, as with all 

analysis tools, they can be misused, and 

researchers are encouraged to understand 

these analyses before selecting and using one. 

The open-source nature of ImageJ also allows 

the development of novel co-localization 

routines. Intensity correlation analysis by Li 
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and colleagues was refined only after 

implementation in ImageJ enabled an 

improved rate of analysis (1, 26) . In this part we 

will mention only one example of the 

application of ImageJ in 

immunohistochemistry and co-localization 

studies which is Fluorescent Cells. 

From imaging library of ImageJ we can open 

an image called Fluorescent Cells as shown in 

figure 5-A. This image is  a bovine pulmonary 

artery endothelial cells stained using 

immunohistochemistry technique where the 

Blue color represents the nucleus stained with 

DAPI, Green color is for Tubulin stained with 

Bodipy FL goat anti-mouse IgG and the Red 

colour is for F-Actin stained with Texas Red 

X-Phalloidin. Figure 5-B shows that ImageJ 

opens this image as a 3 different channel, 8-

bit composite image, this image can be split 

into  3 different images; red green and blue. 

This image shows the location of each 

individual protein in the cell where the Blue 

color is for nucleus, the green color is for 

Tubulin and the Red color is for F-Actin, as 

we mentioned befor. 

            

 

Figure 5.A-a screen shot shows the process of 

opening sample image (Fluorescent Cells) from the 

imaging library of ImageJ.  B-Fluorescent Cell 

From imaging library of ImageJ where split into 3 

different color channels. The cell is a bovine 

pulmonary artery endothelial cell; 1. shows nucleus 

stained with DAPI (blue). 2. shows Tubulin stained 

with Bodipy FL goat anti-mouse IgG (green). 3. 

shows F-Actin stained with Texas Red X-Phalloidin 

(red). 4. shows a merged image of the three 

different cell components. The image sourced from 

(http://imagej.nih.gov/ij/images/FluorescentCells.zi

p) 

A 



 

Academy journal for Basic and Applied Sciences (AJBAS) Volume 7, issue 2, 2025 

DOI: 10.5281/zenodo.16874716 9 

 

To gain a better understanding of this topic, 

see the study Immunohistochemical 

Localization of SyGCaMP2-mCherry (a 

presynaptic calcium sensor) to Presynaptic 

Terminals. Professor Nick Hartell and his 

colleagues tackled the challenge by 

developing a special strain of mice that 

expresses a calcium-sensing fluorescent 

protein within the pre-synaptic terminals of 

their hippocampus (27-29). To confirm that 

SyGCaMP2-mCherry was expressed in 

presynaptic boutons, a series of double 

labelling experiments were performed that 

combined anti-mCherry and anti-bassoon 

labeling. ImageJ lets you highlight the co-

localized points in two 8-bit images (or 

stacks). The two images (or stacks) will be 

affected by an RGB image's two Red and 

Green channels. Co-localized points are 

displayed in white by default. The plugin first 

creates an 8-bit image containing only the 

colocalized points (image available by 

validating Colocalized points 8-bit), and then 

combines the three 8-bit images to produce an 

RGB image. Two points are considered 

colocalized if their respective intensities are 

strictly greater than the thresholds of their 

channels (which are 50 by default: Threshold 

channel 1 (0-255). and if their ratio (of 

intensity) is strictly higher than the ratio 

setting value (which is 50% by defect: ratio 

(0-100%). 

(https://imagej.nih.gov/ij/plugins/colocalizati

on.html) 

Conclusion 

In medical science field, medical image 

processing is a discipline that involves the use 

of technology to take images of the inside of 

the human being in a way that is as non-

invasive as possible .Hence with the 

advancements in medical and biological 

sciences, imaging has become an increasingly 

important discipline. One of the very useful 

softwares is ImageJ which is a public domain 

Java image processing program inspired by 

NIH Image for the Macintosh. It can display, 

edit, analyze, process, save and print 8-bit, 16-

bit and 32-bit images. It can calculate area and 

pixel value statistics of user-defined 

selections. It can measure distances and 

https://imagej.nih.gov/ij/plugins/colocalization.html
https://imagej.nih.gov/ij/plugins/colocalization.html
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angles. It can create density histograms and 

line profile plots. It supports standard image 

processing functions such as contrast 

manipulation, sharpening, smoothing, edge 

detection and median filtering. It does 

geometric transformations such as scaling, 

rotation and flips. Image can be zoomed up to 

32:1 and down to 1:32. All analysis and 

processing functions are available at any 

magnification factor.  

The program supports any number of 

windows (images) simultaneously, limited 

only by available memory. Spatial calibration 

is available to provide real world dimensional 

measurements in units such as millimeters. 

ImageJ was designed with an open 

architecture that provides extensibility via 

Java plugins. Custom acquisition, analysis 

and processing plugins can be developed 

using ImageJ's built in editor and Java 

compiler. User-written plugins make it 

possible to solve almost any image processing 

or analysis problem. 

(https://imagej.nih.gov/ij/docs/intro.html).  

In this paper, we have shown some but not all 

applications of ImageJ in medical field and for 

medical and biological students that can be 

easily applied in their institutes. One of those 

applications was a bacterial cells counting 

where a microscopic image of the gram 

stained bacterial cells captured using a 

student's smartphone, treated using ImageJ 

and the bacterial cells was easily 

automatically counted using ImageJ. This 

software-based methodology is cheaper, more 

standardized and better reproducible than a 

manual-based microscopy methods. 

Therefore, we suggest the application of the 

ImageJ program as an alternative method to 

manual quantification of bacterial cells. The 

second application of ImageJ in this research 

was the calculation of the antimicrobial zone 

of inhibition. By very simple steps, we  were 

able to calculate the percentage of the 

inhibition zone of the three-different brands of 

amoxicillin antibiotic. The amoxicillin 

manufactured at the UK had a larger zone of 

inhibition than the others did which means 

that it is more effective than the others are. 

The third application of ImageJ was to analyze 

a CT scan brain images, where we were able 

to define the hemorrhage location; in addition 

to ImageJ ability to calculate hemorrhage size 

and its ability to generate 3D images of the 

same hemorrhage. Finally, we have 

demonstrated the ability of this free software 

to estimate protein-protein Co-localization. 

This technique is important to many cell 

biological and physiological studies during 

the demonstration of a relationship between 

pairs of bio-molecules (25). In the second 

example of co-localization; the researchers 

https://imagej.nih.gov/ij/docs/intro.html
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confirmed a presynaptic localization of the 

SyGCaM2-mCherry sensor to hippocampal 

synapses, where, the sensor was co-localized 

to a bassoon (a presynaptic protein) in the 

stratum radiatum of area CA1. In general, 

ImageJ is a very useful, free program that can 

be used easily by specialized people and the 

beginner medical students. 

It is worth noting that software applications 

used for diagnostic purposes in a clinical 

setting are considered medical devices and are 

generally subject to regulatory approval from 

authorities such as the Food and Drug 

Administration (in the United States), 

requiring rigorous verification and validation 

procedures (6). 
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